DEGSAI

Departamento de Ciencias de la Computacion e LA.

Sistemas Inteligentes de Gestion
Guion de Practicas de Mineria de Datos
Practica 3

Métodos de agrupamiento [Clustering]

© Juan Carlos Cubero & Fernando Berzal

FICHEROS DE DATOS

Datos de empleados.sav
iris.csv

ENTREGA DE LA PRACTICA

Clustering.doc

DatosApplet
3ClustersSinOutliers{.datal.sav}
3ClustersConOutliers (.datal.sav}
ClusteringDificil.data
Clustering DatosApplet.knime.zip
Clustering DatosApplet.spo
centroides *.pmml

Iris
Clustering Iris.knime.zip

DatosEmpleados
DatosEmpleados.muestra.csv
Clustering DatosEmpleados.knime.zip
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K-Means

= Para la realizacion de esta practica, comenzaremos ejecutando el siguiente aplet,
que nos permitird comprobar el funcionamiento del algoritmo de las k medias
(k-means):

http://home.dei.polimi.it/matteucc/Clustering/tutorial _html/AppletKM.html

Nuestro conjunto de datos, en este caso, estara formado por tuplas con dos
variables de tipo numérico, representables por tanto en el plano. Cada una de las
tuplas de nuestro conjunto de datos correspondera a un punto.

Seleccionando la opcion para mostrar el historial [Show History], inicialice
[[nitialize], pulse Start y ejecute paso a paso el algoritmo [Step] para ver cdmo
van cambiando los centroides y la asignacion de los puntos a sus centroides mas
cercanos.

A continuacion, cree con el WordPad un fichero llamado clustering.doc en el
que ir guardando los resultados obtenidos durante la realizacion de los ejercicios.

Ejercicios tipo C

K-Means paso a paso
Ejecute ahora el siguiente applet:

http://www.cs.ualberta.ca/~valing/Cluster/Applet/Code/Cluster.html

Este applet nos permitira crear nuestro propio conjunto de datos a golpe de raton:

1. Enla lista de conjuntos de datos [Choose a Dataset], escoja la opcion
correspondiente a conjuntos de datos definidos por el usuario [User Define].

2. Como algoritmo [Choose an Algorithm], elija K-Means.
3. Cree un conjunto de datos haciendo click sobre el area entre los ejes X e Y.
4. Pulse el boton Start para ejecutar el algoritmo de clustering.

5. Pulse el boton Show para visualizar los clusters obtenidos como resultado.

Sistemas Inteligentes de Gestion: Clustering



[ Cluster

= C | @ webdocs.cs.ualberta.ca/~yaling/Cluster/Applet/Code/Cluster.htm bkl §
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ImportExport
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Clear

Algorithm: K-means Parameter: k=3

Arbitrarily choose K objects as the ininital cluster centers -
Repeat

(re) Assign each object to the cluster to which the object is most similar

based on the mean value of the objects in the clusters;

Update the cluster means

Until no changes

Done

Al mostrar los resultados, con Show, se muestra cada punto con un color que representa
el cluster al que ha sido asignado cada punto. Los puntos en rojo corresponden a los
centroides de cada agrupamiento.

Usando la opcion Import/Export, podemos generar el conjunto de datos correspondiente
a los puntos que hayamos introducido manualmente. Los pares de valores mostrados por

el applet van separados por un espacio en blanco y se pueden importar ficilmente en
otras herramientas.

Cree una nube de 8 puntos cualesquiera en el plano. Cuando haya generado su conjunto
de datos, incluya sus pares de valores al fichero Clustering.doc y capture la pantalla

de la nube de 8 puntos (con Alt+ImprPant). Incluyala en el fichero clustering.doc
(con Ctri+V).

A continuacion, escoja aleatoriamente dos centroides (indiquelos en Clustering.doc)
y realice una ejecucion manual del algoritmo, incluyendo, para cada iteracion, los
centroides y la tabla de distancias de todos los puntos a los centroides (tantas filas como
centroides y tantas columnas como puntos). Termine la ejecucion en cuanto hayan
transcurrido 5 iteraciones o no varien los centroides.

El ajuste del modelo puede medirse a través de la suma total de distancias al cuadrado
de los puntos a sus centroides (SSE). Calcule el ajuste del modelo determinado por el
valor final de SSE.
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DatosApplet

Utilizando el mismo applet del ejercicio anterior, construiremos los siguientes ficheros
de datos, con al menos 40 puntos en cada uno de ellos:

® 3ClustersSinOutliers.data (nube de puntos con 3 clusters sin outliers).

® 3ClustersConOutliers.data (nube de puntos con 3 clusters bien definidos,
mas 5 valores anomalos o outliers que no pertenezcan a ningtn cluster).

A los dos ficheros anteriores, afiddales una primera linea de texto con el nombre de las
variables (a saber, X, Y).

Capture la pantalla (con A/t+ImprPant) de las tres nubes de puntos generadas y copielas
en el fichero clustering.doc (Ctrl+V).

MUY IMPORTANTE:
Cada alumno debera trabajar con sus propios datos.
No se admitiran dos practicas con los mismos conjuntos de datos.
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K-Means: DatosApplet @ KNIME

Cree un proyecto en KNIME llamado Clustering DatosApplet con los siguientes
nodos que nos permitan agrupar los datos de 3ClustersSinOutliers.data:

e Un nodo para leer el fichero.

e Un nodo Data Manipulation > Column > Normalizer para normalizar los datos,
ya que KNIME implementa k-Means sin normalizar previamente las variables.
Con los datos obtenidos desde el applet no hay ningiin problema, ya que ambas
variables tienen magnitudes similares. Sin embargo, es bueno que nos
acostumbremos a normalizar las variables.

NOTA: Recordemos que, en SPSS, se hacia de la forma siguiente:
Analizar > Estadisticos Descriptivos > Descriptivos > Guardar
valores tipificados como variables.

e Unnodo Mining > Clustering > k-Means para realizar el clustering. Este nodo
afiadird una columna Cluster, indicando el agrupamiento asignada a cada tupla
de nuestro conjunto de datos. En su configuracion, debemos indicar los atributos
que se usaran para establecer los clusters. En nuestro ejemplo, usaremos ambos.

e Unnodo DataViews > Property > Color Manager para colorear los datos
correspondientes a la columna Cluster del nodo anterior.

e Unnodo DataViews > Interactive Table para ver los resultados.

e Dos nodos DataViews > Scatter Plot para ver la nube de puntos original y la
coloreada con los clusters obtenidos.

File Reader Scatter Plot
)
Clustering TresClustetsSinQutliers.data MNube puntos originales
pfmalizer k-Means Color Manager Interactive Table

ME_HME\

u
Mormalizar N(0,1) Clustering k=3 Colorear Clusters Tabla Resultados
Scatter Plot

Mube puntos con Clusters

Para ver los centroides obtenidos, seleccione con la derecha el nodo k-Means y muestre
los resultados (View: Cluster View).
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Para escribir en un fichero los valores asociados a los centroides, seleccionamos un
nodo /0 > Writer > PMML Writer y lo enlazamos con el nodo k-Means. En la
configuracion del nodo PMML, debemos indicar el nombre del fichero de salida,
centroides 3ClustersSinOutliers.pmml €n nuestro caso.

El fichero PMML no es mas que un fichero XML que se utiliza para describir modelos

de mineria de datos. Puede encontrar mas informacion sobre el estandar PMML en:
http://www.dmg.org/
http://en.wikipedia.org/wiki/Predictive_Model Markup Language
http://www.frandzi.corex.es/PWP/frandzi/dm4pmml.html

Observe que, en nuestro proyecto actual, tanto la tabla como la nube de puntos nos
muestran los datos normalizados. Si queremos ver los datos originales, basta hacer lo
siguiente:

e De la salida de k&-Means, mantenga tnicamente el atributo Cluster y el
identificador de fila (RowID). Esto lo podemos hacer con un nodo de tipo
Column Filter aplicado sobre la salida de Color Manager.

e A continuacion, combine el resultado del Column Filter con los datos originales
mediante un nodo Joiner (eligiendo el RowID como Join Column e Inner Join

como método de reunion).

Asi quedaria nuestro proyecto KNIME tras realizar estas modificaciones:

Abra ahora los nodos Interactive Table y Scatter Plot. Si pinchamos sobre un punto en
la nube de puntos y con el raton derecha seleccionamos Hilite, dicho punto se marca
como naranja y, ademas, también se marca el dato correspondiente en la tabla
interactiva.

Dentro del mismo proyecto KNIME, cree ahora un modelo andlogo al anterior para el
otro conjunto de datos, 3ClustersConOutliers.data.

En el fichero clustering.doc, introduzca después de cada nube de puntos los
centroides obtenidos por K-Means y analice si los clusters generados se corresponden
aproximadamente con los agrupamientos que cabria esperar.
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K-Means: DatosApplet @ SPSS

Ahora, lea los datos del fichero 3TresClustersSinoutliers.data desde SPSS. Para
ello, seleccione Archivo > Leer datos de texto e indique que en el fichero de datos
utilizara espacios como delimitadores para separar los valores de las distintas variables:

Asistente para la importacion de texto delimitado - Paso 4 de 6

£ 0ué delimitador =& encuentra entre las vanables? £Cual ez el calificador de texta?
[] T abudlador Ezpacio @ Ninguna
(") Comillas simples
[Coma []Punto y coma
(7) Comillas dobles
[ Otro:
() Ot
Wizta previa de datos
V1 .
a7
114
=11
T4
= v
< Atrds ” Siguiente > Cancelar ] [ Apuda

En la siguiente pantalla del asistente, cambie el nombre de las variables V1 y V2 por X
e Y, respectivamente. Para ambas variables, seleccione “Numérica™ para especificar su
tipo. Finalmente, guarde el fichero resultante en formato SPSS con el nombre

3ClustersSinOutliers.sav.

IMPORTANTE: SPSS no normaliza las variables antes de ejecutar k-Means, por lo
que habria que crear las variables normalizadas (Analizar > Estadisticos
Descriptivos > Descriptivos > Guardar valores tipificados como variables) y
usar k-Means sobre las estas nuevas variables, no sobre las originales.
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A continuacion, seleccione Analizar > Clasificar > Conglomerado de K-medias.
Asegtirese de incluir las dos variables de nuestro conjunto de datos y escoja 3 como
numero de "conglomerados" (el valor del parametro k):

B Andlisis de conglomerados de K-medias @

Wariables:
&% =
P Pegar

<]

Restablecer

: Cancelar
Etiguetar los cazos

rmediante: Apuda

]

M? de conglomerados: 3 M &todo

(%) Iterar v clasificar () 5élo clasificar
Centroz de loz conglomerados
[ Leer iniciales:
[ Esciibir finales:

[ Iterar... l [ Guardar... ] [ Opciones... ]

Lance el "analisis de conglomerados" y, una vez ejecutado el algoritmo de las K
Medias, apareceran los centroides de los agrupamientos:

NOTA: Para que los valores asociados a los centroides aparezcan con decimales,
debera indicarlo en las opciones de las casillas:

Centros de los conglomerados finales

Conglomerado

H
Corkar Chrl+s
Copiar Chrl+C
Pegar Chrl+y
Barrar Supr
Nimero de casos en cada conglomera|  3eleccianar tabla
Conglomerado 1 20,000  Crear grafico 3
2
44,000 Propiedades de tabla. ..
3 29,000

Validog 93,000

Propiedades de casila...

Aspectos de tabla. ..
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Cuando trabaje con variables normalizados, debe tener en cuenta que los centroides
también estaran normalizados. Para averiguar cudles serian los valores originales (no
normalizados) correspondientes a los centroides, debe deshacer la tipificacion. Es decir,
debe multiplicar el valor normalizado por la desviacion tipica y sumar la media
aritmética (para cada una de las variables) .

Incluya en el fichero clustering.doc las tablas correspondientes a los centroides,
tipificados y no tipificados.

(Salen los mismos resultados que los obtenidos con KNime? Razone la respuesta e
incluya su razonamiento en el fichero clustering.doc.

Repita el mismo estudio para el otro conjunto de datos: 3clustersConOutliers.data.

Antes de terminar, aseglrese de guardar los resultados de su sesion completa en SPSS,
que deberd entregar en un fichero que se llame Clustering DatosApplet.spo.

NOTA:

Weka si implementa k-Means normalizando previamente las

variables. Ademas, usa una variante de k-medoids para poder trabajar
también con atributos nominales. En este caso, los centroides se
construyen usando la media aritmética de los puntos del cluster para cada
variable numérica y la moda de los puntos del cluster para cada variable
nominal.
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Clustering jerarquico

=== Ejecute el applet disponible en http://metamerist.com/slhc/example40.htm

Este applet muestra un conjunto de datos de ejemplo sobre dos variables. Paso a
paso, muestra como un algoritmo de clustering jerarquico aglomerativo va
formando clusters (usando la distancia euclidea para medir la distancia entre dos
puntos). Al principio se conectan los dos puntos mds cercanos, formando un
primer cluster con dos elementos. Progresivamente, se irdn uniendo puntos a
clusters y clusters entre si, mostrando cada cluster de un color. Al finalizar el
proceso, nos quedara un unico cluster.

Ejecute varias veces el applet con distintos conjuntos de datos de partida.

Clustering jerdrquico: DatosApplet @ SPSS
Abra el fichero Clustering DatosApplet.spo que ya creamos en la seccion anterior.
Seguiremos trabajando en €l sobre los datos que ya teniamos en

3ClustersSinOutliers.sav.

Para lanzar un algoritmo de clustering jerarquico en SPSS, seleccione
Analizar > Clasificar > Conglomerados Jerarquicos.

A continuacion, asegurese de escoge las siguientes opciones:

Incluya las dos variables (X, Y) a la hora de realizar el clustering y, pinchando en el
boton Grdficos..., indique que desea crear un dendrograma.

IMPORTANTE: Como sucedia con el algoritmo de las K Medias, por defecto no se
normalizan las variables, a no ser que se indique explicitamente mediante la opcién
Estandarizar de la ventana que aparece al pulsar sobre Método... Hagalo.
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Haga doble click sobre el dendrograma obtenido en el visor de resultados. Se abrira otra
ventana, en la que se puede editar (en formato de texto) dicho dendrograma. Quite el
texto necesario para que no se vea partido y copielo en el fichero clustering.doc.

Identifique de alguna forma los 3 clusters naturales que deberian salir. Para ello, puede
usar colores diferentes (o algo mas sofisticado si utiliza un procesador de textos menos
rudimentario que el WordPad).

En el visor de resultados de SPSS (al igual que en Clementine y Weka), también
aparece el nimero de ejemplos que han sido asignados a cada cluster. En cualquier
estudio, habria que analizar estos datos detenidamente, ya que es posible que
tuviésemos que dividir aquellos clusters que tuviesen demasiados ejemplos
(aumentando k) , lo que sucede a menudo ante la presencia de outliers (el outlier seria
un cluster y todos los demas datos quedarian englobados en otro). No obstante, hay que
se cuidadoso con este tipo de cosas, ya que también pueden existir agrupamientos
naturales que engloben a una parte significativa de nuestro conjunto de datos.

Deteccion de outliers: DatosApplet @ SPSS

Veamos ahora como detectar outliers. Si usamos un algoritmo de clustering jerarquico,
un caso extremo o outlier se unira en algin momento a aquel cluster que esté mas
cercano a ¢€l. Si bien que un cluster contenga muchos ejemplos no quiere decir que
necesariamente contenga outliers, lo que si es cierto es que un outlier se unira siempre a
un cluster en las fases finales del agrupamiento jerarquico: los outliers seran aquellos
valores que, de forma aislada, se unen a algun cluster en las tltimas iteraciones del
algoritmo jerarquico.

Cargue desde SPSS el fichero 3clustersConoutliers.sav y vaya afiadiendo su
andlisis al fichero Clustering DatosApplet.spo.

Realice ahora un clustering jerarquico, copie el dendrograma en el fichero
Clustering.doc e inspeccidnelo para detectar los valores correspondientes a los
outliers, indicando en el fichero cuales son.

A continuacion, elimine los registros corresondientes a los outliers del conjunto de datos
(bien fisicamente, o bien excluyéndolos del analisis) y vuelva a ejecutar el algoritmo de
las k Medias con k=3. Guarde la tabla de centroides resultantes en Clustering.docy
compare los centroides obtenidos al incluir los outliers y al excluirlos del analisis.
Analice ambos resultados (y no olvide incluir sus comentarios en Clustering.doc).

CUIDADQO: Cada vez que se elimina un registro, SPSS cambia todos los
identificadores. Si vamos a eliminar los registros con identificadores 35 y
40, por ejemplo, y borramos primero el 35, el segundo registro que
queriamos borrar tendra ahora el identificador 39. Para evitar errores,

lo mejor es eliminar los registros de mayor a menor orden.
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K-Means: Iris @ KNIME

Copie el fichero iris.csv (disponible en la web de DECSAI) y cree un proyecto en
KNIME llamado Clustering Iris.

Este conjunto de datos, muy conocido, contiene las longitudes y anchuras de pétalos y
sépalos de 150 muestras correspondientes a tres variedades de plantas de tipo Iris
(lirios), ademas de un quinto atributo class que indica el tipo concreto de Iris (Setosa,
Virgina o Versicolour) . Mas informacion sobre este conjunto de datos en
http://archive.ics.uci.edu/ml/datasets/Iris

Para ver si las caracteristicas morfologicas de las muestras determinan el tipo de Iris,
utilizaremos un algoritmo de agrupamiento como el de las K Medias.

En su proyecto de KNIME, lea los valores del fichero iris.csv, elimine el atributo
class y normalice los atributos numéricos. A continuacion, utilice k-Means con k=3 e
indique en Clustering.doc cudles son los centroides que ha encontrado.

Finalmente, construya una tabla con los datos originales, incluido class, y afiada el
atributo Cluster que indique el cluster al que ha sido asignada cada muestra de iris. En
una tabla interactiva, puede seleccionar la cabecera de una columna con el ratéon y
arrastrarla al sitio que se quiera, de tal forma que puede colocar class y Cluster en
columnas adyacentes.

Para ver en cuantos registros se ha "acertado" al agrupar los datos, utilice un nodo
Mining > Scoring > Scorer, filtrando antes todas las columnas excepto class y Cluster.
Este nodo cuenta el nimero de registros que contienen cada uno de los valores de class,
cruzandolos con todos los de Cluster. Exporte la tabla resultante del nodo Scorer (con
File > Export as PNG) ¢ incluya el grafico en el Clustering.doc junto con sus
comentarios sobre los resultados obtenidos.

Clustering jerdrquico: Iris @ KNIME

Anada un nodo Mining > Hierarchical Clustering a su proyecto KNIME. Conéctelo a
sus datos de entrada (quitando previamente la columna class y normalizando variables).
Configure el nodo para que que se utilice la distancia euclidea y single linkage. Ejecute
el algoritmo de clustering y copie el dendrograma en el fichero clustering.doc (View
> Dendrogram/Distance View y, sobre la ventana que aparece, File >Export as PNG).
Analice los resultados e indique los grupos que se aprecian en el dendrograma.
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Para comprobar si los grupos marcados en el dendrograma coinciden con los obtenidos
por k-Means o con los datos originales, puede seleccionar una zona del dendrograma
con el raton y seleccionar Hilite. Si tenemos abierta la tabla con los datos originales, se
marcaran automaticamente los correspondientes registros y podremos comprobar si
coinciden los valores de class (versicolor, setosa, virginica).

Anada ahora otro nodo de clustering jerarquico, pero esta vez utilice la distancia
euclidea con average linkage. Cope el dendrograma en el fichero clustering.doc,
comparelo con el dendrograma anterior y analice los resultados.

En la ventana en la que se muestra el dendrograma, hay una pestaia Distance que
muestra los valores de SSE (la suma de las distancias al cuadrado de cada punto al
centroide de su cluster). Esto puede resultar bastante util para determinar el valor mas
adecuado de k. Cuanto mayor sea k, menor serd el valor de SSE, pero habra un punto a
partir del cual la ganancia no sera significativa. Este sera el punto que determinard el
valor mas adecuado para k.

©h
il

Exporte el grafico anterior para los dos clustering jerarquicos que ha realizado y
proponga cudl seria su recomendacion sobre el valor k (que posiblemente estaria entre 4
y 6 para la figura que se muestra arriba).

NOTA: SPSS oftrece otro método de clustering ("en dos fases"). Este no es mas
que una variante del método BIRCH en la que se obtiene autométicamente una
estimacion del valor k usando precisamente el grafico anterior. Asi pues, el
resultado de este método es directamente es una tabla de centroides, pero sin
tener que indicar a priori el valor de k (ni estimarlo manualmente).
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Datos de Empleados

Cargue los datos de empleados en SPSS. Como son bastantes datos, el clustering
jerarquico puede ser muy ineficiente, por lo que seleccionaremos un 40% de la muestra
aplicando un filtro con Datos > Seleccionar Casos > Muestra Aleatoria. Guarde los
datos en formato csv, en el fichero DatosEmpleados.muestra.csv.

Cree un nuevo proyecto en KNIME, llamado Clustering DatosEmpleados para leer
los datos de nuestra muestra de empleados y lanzar un algoritmo de clustering
jerarquico. No olvide realizar todas las operaciones de preprocesamiento que estime
necesarias, como, por ejemplo, seleccionar las variables que se utilizaran en el método
de agrupamiento. Copie el dendrograma resultante y el grafico de distancias SSE en el
fichero clustering.doc. Estime un valor adecuado para k.

A cotinuacion, utilice el método de las K Medias utilizando el valor estimado para k
mediante el algoritmo de clustering jerarquico. Guarde la tabla resultante de centroides
en Clustering.doc € interprétela en términos de los k perfiles o prototipos de clientes
que haya obtenido.

DatosApplet

Cree con el applet utilizado al principio de este guion una nube de puntos que
corresponda a tres clusters cuya forma sea dificilmente detectable por el método de las
K Medias (por ejemplo, clusters no esféricos o de distinta densidad). Guarde los puntos
generados en el fichero ClusteringDificil.data.

Utilice KNIME para realizar un agrupamiento basado en un nodo de tipo Weka >
Cluster Algorithms > SimpleKMeans, configurado para un valor de k=3. Muestre el
ajuste final del modelo, indicando el valor SSE (este dato esta disponible en la salida del
nodo Weka, etiquetado como Within cluster sum of squared error).

Estime ahora un valor de k con un diagrama SSE (pestafia Distance view del nodo de
clustering jerarquico) y vuelva a lanzar el algoritmo de las K Medias. Indique de nuevo
el valor SSE y compadrelo con el anterior. Incluya los graficos obtenidos y la discusion
que se estime oportuna en el fichero clustering.doc.

r’" N EVALUACION DE LAS PRACTICAS
¢ A+) ol
LY = El fichero clustering.doc ha de incluir todas sus respuestas

a las distintas preguntas que aparecen en este guion.
4 ‘ *
PD: No olvide incluir también sus proyectos KNIME y el

4 9
e i\*-.-»/ fichero correspondiente a su sesion en SPSS.

8]
L
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